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1   Overview 

PIPES for WINDOWS is used to calculate the flows and 
pressures in pressure pipe systems.  Components which 
can be modelled include: 

 Reservoirs 

 Pipes 

 Pumping Stations 

 Minor Head Losses 

 Check Valves 

 Pressure Reducing Valves 

 Pressure Sustaining Valves 

 Flow Control Valves 

 Sprinklers 

 Hydrants 

 Hose reels 

 Town Mains 

Pipe flows may be calculated using either the Colebrook 
White equation or the Hazen Williams equation.  You 
draw the network on screen using lines to represent pipes 
and pre defined symbols to represent pumps, valves and 
reservoirs.  If you already have the pipes drawn in a CAD 
system (eg Autocad) you can create a DXF file of the 
pipes and nodes.  PIPES can then read this DXF file.  
Data is entered via dialog boxes which are accessed by 
right clicking on the pipe or symbol, and selecting Edit 
Data. 

There is no limit on the number of pipes, nodes etc which 
can be modelled.  If your computer has sufficient RAM 
you can model any size network.   

PIPES can be installed in its normal version or in the 
Building Services version.  In the Building Services 
industry, it is common practice to use diversity factors 
which reduce the probable simultaneous flow per fitting 
as the number of fittings increases.  The Building 
Services version includes automatic diversity calculations. 

 

 

 

 

 

2   Equipment 
Required 

You will need a machine with Windows 98 or later.  You 
will also need the software lock supplied with PIPES to 
run the full version.  The demo version does not require a 
lock. 

 

 

 

3   Getting Started 

A CD containing all the PIPES files and a software lock 
are provided with the full version of PIPES.  The software 
lock should be attached to a parallel port on your 
computer.  Files on the CD are compressed and you must 
install PIPES on your hard disk before using it. You 
should start Windows Explorer, select the drive 
containing the PIPES CD and double click SETUP.EXE 
in the PIPES directory.  This will decompress the files 
and copy them to your hard disk.  You will have the 
choice of installing either the Building Services version 
or the normal version. 

PIPES incorporates an extensive online help system and 
we encourage you to use it.  You can access the help 
system from the Help menu, or by pressing F1, or using 
the Toolbar help button.  Clicking the Toolbar help 
button puts PIPES into help mode.  You can then click on 
any object (eg a menu item, another symbol in the 
toolbar, a pipe, a node etc) to get specific help on that 
object. 

You might like to experiment with the sample data file 
SMALL.PIP which is supplied with PIPES. 
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4   Using the Mouse 

Clicking on a shape, such as a node or pipe, will 
highlight it.  You can perform various operations on a 
highlighted shape such as deleting it or moving it around 
the screen.  To move a highlighted shape you drag it 
using the mouse. 

To open a dialog box relating to a shape right click on the 
shape and select Edit Data from the pop up menu.  For 
example, in the dialog box for a pipe you can enter the 
pipe length, diameter, roughness etc. and view results of 
the analysis. 

 

 

 

 

5   Menu Commands 

All of the menu commands can be accessed from the 
menu bar shown in the figure below.  In addition many of 
the commands can be accessed from the tool bar below 
the menu bar.  The commands behave in the same 
manner regardless of how they are accessed. 

File Menu 

 

Many of the choices available from the File menu are 
common to most Windows Applications. 

New allows you to clear the current drawing, ready to 
start a new network. 

Merge Another File allows you to add the details from 
another PIPES file to the current diagram.  The merging 
file must have two nodes in common with the current 
diagram so that PIPES can determine the correct 
orientation and scaling for the file to be merged. 

Read DXF allows you to read information stored on a 
DXF file.  These files can be created by most CAD 
packages.  If you already have pipes shown on a CAD 
drawing this feature will save you some time in drawing a 
network and entering pipe data.  You will be prompted to 
supply the Pipe layer name and the Node layer name.  
PIPES will interpret all straight lines and circles on these 
layers of the DXF file as pipes and nodes respectively.  
This means that no other straight lines or circles can be 
drawn on these layers.  It is not necessary to draw all 
pipes and nodes on the DXF file.  You can add pipes and 
nodes later from within PIPES.  You will be asked if the 
DXF drawing is drawn to scale.  If you answer yes, PIPES 
will assign a length to all pipes based on the length you 
enter for one pipe. 

Merge Watsys data file is useful if you have data files 
prepared for Watsys.  Conversion of these data files is 
described in Appendix A.  

Write DXF allows you to create a new DXF file of the 
pipes and nodes or to update an existing file.  You might 
wish to update an existing drawing if you have changed 
the number or location of pipes while working in PIPES.  
If you update an existing DXF file, the information on 
other layers will be retained unchanged. 

Print allows you to print the current network diagram, 
the results of an analysis and HGL graphs for a series of 
pipes.  Before printing, you will have the opportunity to 
change printer settings (eg Landscape or Portrait mode, 
etc).   The information shown on a network diagram plot 
depends on values set under View/Pipe Text and Colors 
and View/Node Text and Colors.  These menu items are 
described on page 19. 

Print Setup allows you to change printer settings, add a 
new printer, remove an old printer etc.   

Exit will close PIPES.  If you have made changes to the 
current network you will be asked whether you wish to 
save them. 

Below Exit is a list of up to 4 of the most recently opened 
files.  Clicking on one of these files is the easiest way to 
open a file you were recently using. 
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Edit Menu 

Undo and Redo can be used to change recent actions 
such as drawing new shapes, moving shapes, deleting 
shapes and editing data for a shape.  When these menu 
items become active the text will change to indicate the 
type of action to be affected (eg Undo might change to 
Undo Edit Data). 

Find a Node allows you to easily locate a node in the 
network.  This is useful on large drawings, especially if 
you are not very familiar with the network. 

Find ????? allows you to find a shape for which data is 
incomplete.  This is useful on large drawings if PIPES++ 
cannot calculate results because there is some shape for 
which data is incomplete, but you don’t know which 
shape it is. 

Copy Current Diagram will copy the network diagram 
to the Clipboard.  You can then paste it into your 
Windows Word Processor or Windows Drawing Program 
for inclusion in a report. 

Copy Data to Spreadsheet will copy the current pipe and 
node data to the clipboard.  You can then paste this data 
into a spreadsheet by placing the cursor in cell A1 of the  

spreadsheet and selecting Edit / Paste.  You can then 
format the data to make it more readable.  You might 
make the headings bold, center the text in cells 
containing numbers etc. 

Copy Results to Spreadsheet will copy the current pipe 
and node results to the clipboard.  You can then paste 
these results into a spreadsheet.  This is useful for large 
networks where it can be difficult to identify nodes with 
low pressures, pipes with high friction losses or velocities.  
With the results shown in a spreadsheet you can use the 
spreadsheet’s capabilities to quickly identify problem 
areas.  For example, you can sort the node results based 
on pressure to see all the problem pressures.  You can 
also sort the results based on pipe friction slope to identify 
the best candidates for augmentation to overcome low 

pressure problems. 

Paste Data from Spreadsheet can be used to edit the 
data in a spreadsheet, add new pipes and nodes, or even 
to create a new network directly from data entered into a 
spreadsheet.  It is recommended that you first paste data 
into a spreadsheet.  You can then edit the data.  For 
example you might change some pipe diameters and add 
levels and demands to nodes.  When you are satisfied 
with the changes you select (highlight) all the rows from 
row 1 to the last row of pipe data.  Then you select Edit / 
Copy to copy the data to the clipboard, then use Alt-tab to 
switch to PIPES and select Edit / Paste Data from 
Spreadsheet.  Any changes that you have made in the 
spreadsheet will then be made within PIPES and any new 
pipes or nodes that you added in the spreadsheet will be 
created in PIPES. 

If you add a new node in the spreadsheet you will need to 
provide an x,y coordinate for it.  If you change a pipe type 
the text must exactly match a pipe type in PIPES data 
base.  The safest way to do this is to copy a pipe type from 
another cell and paste it into the cell to be changed.Copy 
Current Diagram will copy the network diagram to the 
Clipboard.  You can then paste it into your Windows 
Word Processor or Windows Drawing Program for 
inclusion in a report. 

Delete allows you to delete a pipe, pump valve etc.  First 
you click on the item to highlight it.  You can then press 
the Del key or select this menu item to delete it. 

Job Description allows you to document this job in 
detail.  You can enter notes such as new pipes included in 
this analysis, the fact that this analysis uses Peak Day 
Demands for Year 2010 etc. 

Title Block allows you to edit the text which appears in 
the bottom right of the drawing.  This text may not 
always be visible on the screen.  If you pan to the bottom 
right of the drawing (using the arrows or sliders on the 
bottom and right of the drawing) you will see the text.  If 
you do not want to show a title block you can simply 
delete all three lines of text. 

Pipe Data Base allows you to edit the pipe data base.  
The data base contains internal diameters for a range of 
common pipe materials and classes.  You can add or 
remove pipe types and pipes.  The pipe data base was 
introduced with Versions 95.20.  If you are using data 
files prepared with an earlier version of PIPES the data 
base feature will be temporarily disabled. 
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Draw Menu 

 

Rules for Drawing a 
Pipe Network 

The Draw menu is used to enter the details of your pipe 
network.  A glance at this menu will show that you can 
include nodes, reservoirs, pipes, minor head losses, 
pumping stations, check valves, stop valves, pressure 
reducing valves, pressure sustaining valves, sprinklers, 
hydrants, hose reels and town mains.  You can also draw 
these items using the Toolbar. 

Before discussing these components in detail, there are 
some rules which you must follow in drawing a pipe 
network.  These are: 

 reservoirs, sprinklers, hydrants and hose reels are 
located at a node.  That is, the base or corner of 
these items should just touch one node.  If there is 
too big a space between the item and its node, 
PIPES will not associate the item with that node.   

 pipes are located between two nodes.  That is, each 
end of a pipe should just touch one node.  If there 
is too big a space between the end of a pipe and its 
node PIPES will not associate the pipe with that 
node. 

 minor head losses, pumping stations and all types 
of valves are located between two nodes.  That is, 
you should draw two nodes, one on each side of 
these items.  The space between the item and its 
nodes is not important, but about 5 mm is 
recommended for appearances sake.  You will be 
prompted to supply the name of the upstream and 
downstream node in a dialog box.  Note: If you 
draw a pipe from N1 to N2 and a valve from N1 to 
N2, the pipe and the valve will be in parrallel.  If 
you want them in series you will need another 
node (eg draw the valve from N1 to N2 and the 
pipe from N2 to N3). 

 a Town Main is a special type of node which you 
can use if you are analysing pipework supplied 
from a Town Main.  The local Water Authority 
will supply maximum and minimum HGLs at the 
town main.  Pipes, minor head losses, pumping 
stations and all types of valves can be located 
between a Town Main and another node. 

 

 

Nodes 
A node is shown as a small circle on the network 
diagram.  It is an essential part of the network diagram 
and is used as follows: 

 pipes are drawn from one node to another node 

 valves, pumping stations and minor head losses 
are drawn between two nodes 

 reservoirs, sprinklers and hydrants are drawn 
touching one node 
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To draw a node: 

 select Node from the Draw Menu, or click on the 
node button in the Toolbar 

 place the mouse cursor where you want the node 

 press and hold down the left mouse button 

 you can move the mouse to place the node 
precisely.  When the node is correctly located 
release the mouse button. 

Hint:  To draw many nodes hold down the Shift key as 
you release the mouse button.  You will then be ready to 
draw another node immediately. 

The procedures described here for drawing a node, apply 
to the various other network components.  The use of the 
Shift key applies to nodes and pipes only. 

Data for a node is optional.  You can specify the elevation 
at the node and you can specify details about demand 
from the node.  To enter data for the node point to it, 
right click and select Edit Data from the pop-up menu.  A 
dialog box will appear and you can enter data for 
elevation, and demand details. 

Hint:  You can keep your drawing looking tidy by 
moving the node label (simply drag it with the mouse).  
When results have been calculated the label will be 
replaced by the HGL value which may require a little 
more space.  If necessary you can drag the HGL value to 
suit. 

In the normal version of PIPES, demands from a node are 
allocated to one of ten areas. Each area can have a 
different multiplying factor which is applied to all 
demands in that area.  The dialog box shown below 
appears when you right click on a node, and select Edit 
Data from the pop-up menu. 

 

 

 

 

In the Building Services version of PIPES the dialog box 
for a node is different.  The dialog box comes 
preconfigured with the fittings shown below.  You can 
change these fitting names and change the values of 
Loading Units (L.U.) per fitting if you wish.   

You specify the number of each type of fitting and PIPES 
calculates the Probable Simultaneous Flow (PSF) for all 
fittings in Litres per second.  For less than 70 L.U.s the 
program obtains the PSF from Table 3.3 in AS3500 Part 
1 - 1992.  It has been common practice in Australia to 
convert L.U.s to PSF using Table 48 in The Selection and 
Sizing of Copper Tubes for Water Piping Systems by 
Barrie Smith (published by The Institute of Plumbing 
Australia).  For greater than about 70 L.U.s Table 48 
gives considerably higher flows than the formula used to 
produce Table 3.3.  For this reason, we have not used this 
formula for more than 70 L.U.s, but have used a number 
of straight line relationships which give a PSF similar to 
Table 48. 

The dialog box also allows you to enter a constant flow 
(Litres per second) which is not diversified.  For example 
you might use this for a bank of showers which are likely 
to all be used at the same time. 

 

 
 

In the Building Services version of PIPES, the diversity 
calculations are carried back as far as a ring or loop main.  
In other words, flows in the branching sections of pipe 
system may not satisfy continuity.  In the normal version 
of PIPES flows always satisfy continuity. 

 

Reservoirs 
Selecting Reservoir, or clicking the Reservoir button in 
the Toolbar,  allows you to draw a reservoir.  When you 
do this you will notice ????? appears beside the reservoir.  
This indicates that some data is required for the reservoir.  
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Right click on the reservoir and choose edit data.  You 
can now type in this data. 

If you have drawn the reservoir at a node (as you should) 
PIPES will show the node label in the title bar of the 
dialog box (eg "Reservoir at Node N1").  If the reservoir 
is not drawn at a node, the title bar will show only 
"Reservoir". 

When PIPES is satisfied that all essential data has been 
specified for the reservoir, and that the reservoir is drawn 
close to a node, the ????? will disappear from the 
drawing.  If you have specified a name for the reservoir, 
this name will appear in place of the ?????. 

 

Pipes 
Selecting Pipe, or clicking the pipe button in the Toolbar,  
allows you to draw a pipe.  Point to the pipe starting point 
and press the left button (don't release it yet).  Now move 
the mouse and you will see the pipe follow the mouse 
movement.  When you are satisfied with the pipe location 
release the left button. 

Not satisfied with the location?  Highlight the pipe 
(simply click on it).  You can now drag the entire pipe or 
drag only one end.  To drag the entire pipe, point near the 
centre of the pipe and drag from there.  To drag one end, 
point to that end and drag it. 

Hint:  To draw many pipes hold down the Shift key as 
you release the mouse button.  You will then be ready to 
draw another pipe immediately. 

To enter data for a pipe right click on the pipe and select 
Edit Data from the pop-up menu to bring up the dialog 
box.  When all data is specified, and both ends of the pipe 
are touching a node, the ????? will be replaced by the 
diameter (unless you have requested some other item of 
data from the View/Pipe Details menu).  If the text 
associated with a pipe (????? or diameter etc) is badly 
located you can simply drag it elsewhere. 

Prior to Version 95.20 you were required to specify the 
internal diameter of each pipe.  If you are working with 
data files prepared with an older version of PIPES this 
still applies.  However, for new data files you will select 
the pipe type (eg uPVC to AS1477 Class 12) and nominal 
diameter from drop down list boxes in the dialog box.  If 
the pipe you wish to use is not in the pipe data base you 
can add it by editing the data base under the menu item 
Edit / Pipe Data Base. 

The dialog box will allow you to specify: 

 Length 

 Pipe Type 

 Nominal Diameter 

 whether to use the default roughness specified in 
the pipe data base, or to specify a different 
roughness for this pipe 

 Details of minor head losses (valves, bends and 
fittings) to be included with the pipe.   

Hint:  It is simpler to lump valve and fitting losses in 
with a pipe rather than to model them as a separate minor 
head loss. 

 

Kinked Pipes 
Occasionally you may wish to draw a pipe as a series of 
straight lines (eg when drawing a second pipe between 
two nodes).  Selecting Pipe with Kinks allows you to do 
this.  You draw the first segment as you would a normal 
pipe.  Then move the mouse to draw the second segment 
and click once to lock it in place.  Repeat this process for 
additional segments.  Click with the RIGHT mouse 
button to lock the last segment in place.   

After you have drawn it, a kinked pipe is very similar to a 
normal pipe.  The only difference is that you can drag the 
kinks as well as the ends. The kinks are symbolic only, 
and there is no headloss associated with these kinks. 

 

Minor Head Loss 
A minor head loss should be drawn between two nodes.  
Minor head losses can be used to model anything which 
has a head loss proportional to flow squared.  

                ie Headloss = a.Q2 

The data required is the nominal diameter and K where 

               Headloss = KV2 / 2g 

You can draw a minor head loss, enter data for it and 
inspect the results of an analysis as you would for any 
network component. 

 

Pumping Station 
A pumping station should be drawn between two nodes.  
A pumping station can contain several different pumps.  
Clicking the Pump Details button allows you to define 
three points on the pump Q - H curve for each pump in 
the station. 

You can draw a pumping station, enter data for it and 
inspect the results of an analysis as you would for any 
network component. 
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Check Valve 
A check valve should be drawn between two nodes.  
Check valves will allow flow in the forward direction 
only.  They will close to prevent reverse flow if necessary.  
The data required is the nominal diameter and K where  

               Headloss = KV2 / 2g 

Open or Closed Valve 
This valve is useful if you want to examine the effect of 
isolating a part of the network.  The dialog box allows 
you to specify whether the valve is open or closed. 

Pressure Reducing 
Valve 

A pressure reducing valve should be drawn between two 
nodes.  A pressure reducing valve will automatically 
throttle flow to limit the maximum downstream pressure 
to a preset value.  The data required is the downstream 
HGL setting, the nominal diameter and K where Headloss 
= KV2 / 2g. 

Pressure Sustaining 
Valve 

A pressure sustaining valve should be drawn between two 
nodes  A pressure sustaining valve will automatically 
throttle flow to sustain the upstream pressure at a preset 
minimum value.  The data required is the upstream HGL 
setting, the nominal diameter and K where 

               Headloss = KV2 / 2g 

 

Rate of Flow Control 
Valve 

A rate of flow control valve should be drawn between two 
nodes  This valve will automatically throttle flow to limit 
the maximum flow to a preset value.  The data required is 
flow setting, the nominal diameter and K where 

               Headloss = KV2 / 2g 

 

Sprinkler 
A sprinkler should be drawn touching one node.  The 
data required is the elevation (RL) of the nozzle and the 
flow at some pressure. 

 

 

Hydrant 
A hydrant should be drawn touching one node.  The data 
required is the elevation (RL) of the outlet and the 
required flow. 

 

Hose Reel 
A hose reel should be drawn touching one node.  The data 
required is the elevation (RL) of the outlet and the 
required flow. 

 

Town Main 
A Town Main is a special type of node.  If you are 
designing pipework supplied from a Town Main you 
might wish to use this.  The local Water Authority can 
supply the maximum and minimum HGL in their main.  
If they supply the maximum and minimum pressure at a 
specified level, you can calculate the maximum and 
minimum HGLs by adding the pressure (expressed in 
metres) to the ground level (in metres).  The data required 
is the Hydraulic Grade Level (HGL).   

 

Borehole Drawdown 
Device 

A borehole drawdown device should be drawn between 
two nodes.  This device simulates the drawdown from the 
static water level to the pumping water level in the 
borehole.  Flow through the soil is assumed to be laminar 
and the headloss equation is dH = BQ.  The data required 
is the drawdown (in metres) for a pump out rate of 1L/s 
(this defines B in the equation). 

A reservoir on the device’s upstream node should be set 
with a water level equal to the static water level.  
Headloss through the device will then produce the 
pumping water level (HGL) at the device’s downstream 
node.  You should draw a pump station in series with this 
device (i.e. downstream of the device). 
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View Menu 

 

Drawing Area 
You have probably realised by now that you cannot hope 
to fit a large pipe network on a single screen.  When you 
start a new drawing PIPES allocates a drawing area the 
size of 4 screens (2 vertically by 2 horizontally).  In other 
words, when you start PIPES you are looking at the top 
left hand quarter of the available drawing area. 

You can think of the screen as a window through which 
you can see only part of the entire drawing.  You can 
move this window around the drawing area using the 
scroll bars to see any part of the drawing.   

Index Sheet allows you to quickly zoom out to look at the 
entire drawing.  It also lets you quickly locate the viewing 
window precisely where you want it.  If you find yourself 
getting lost looking at a small part of a larger drawing 
this will be helpful.  When you select Index Sheet, you 
will see the entire drawing on one screen and a dashed 
rectangular box.  This box indicates the present position 
of the normal view window.  You can drag this box 
wherever you want to position the normal view window.  
Releasing the left mouse button will return you to the 
normal view window. 

HGL Graphs will show a graph of HGL along one or 
more pipes. You can nominate the nodes along each pipe 
route.  See page 24 for more details. 

Zoom will be useful if you find your drawing is too 
cluttered or too spread out.  This can happen when you 
read a DXF file or if you are inexperienced in drawing a 
network diagram in PIPES. You will be prompted for a 
magnification factor. 

If you work with large networks, sooner or later you will 

find that the 4 screens of drawing area are insufficient (ie 
your network has "run off the page").  When this 
happens, you can choose Extend Drawing Area.  This is 
like sticking more paper to your drawing.  The size of 
your entire drawing area increases, but you can see no 
more on one screen (ie the size of the view window does 
not change). 

Crop Drawing Area allows you to trim the edges of the 
drawing area.  You can crop right down to the size of one 
screen full. 

Extending or Cropping the drawing area adds or subtracts 
one half a screen width and height each time you do it.  If 
you inadvertently lose some of your network when you 
Crop the drawing it will reappear if you Extend the 
drawing. 

Toolbar can be used to show or hide the Toolbar.  The 
check mark indicates that the Toolbar is currently visible. 

Status Bar can be used to show or hide the Status Bar.  
The check mark indicates that the Status Bar is currently 
visible. 

 

Pipe and Node Details 
When you draw a network there is some text associated 
with each node and pipe.  When you first draw a network 
this text shows the node labels and the pipe diameters.  
After you calculate results, the text shows the node HGLs 
and the pipe flows.  Using Node Text and Colors and 
Pipe Text and Colors you can change this text to show 
other data or results. 
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You can also use these menu items to colour code the 
results.  For example, selecting Node Text and Colors 
shows the dialog box in the figure above.  The user has 
then specified that the pressure should be displayed at 
each node and that the nodes should be colour coded 
based on the value of pressure.  In this example, the user 
has specified pressures up to 12 m should be red, 12 to 20 
should be cyan, 20 to 125 should be yellow, and greater 
than 125 should be green.  The square boxes, shown 
black in the above figure, appear as colours when you use 
PIPES. 

 

Options Menu 
Flow Units allows you to choose between various units.  
You should select your preferred option before entering 
data for pumps, valves, demands etc.  The Building 
Services of PIPES works in Litres per second only, and 
this option is not available. 

Headloss Formula allows you to choose between the 
Hazen Williams and Colebrook White formulae for 
headloss in pipes. You should choose the formula you 
prefer before entering data for pipes. The Building 
Services version of PIPES uses the Colebrook White 
equation only, and this option is not available. 

The Hazen Williams equation is described in most 
standard hydraulic texts.  The Colebrook White equation 
is: 

  V gDS k
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v
D gDS

  












2 2
37

2 51
2

log
.

.
 

  where   V = velocity of flow 

   g  = acceleration due to gravity (m/s2) 

   D = pipe internal diameter (m) 

   S = slope of Hydraulic Grade Line 

   k = pipe wall roughness (m) 

   v = kinematic viscosity of fluid (m2/s) 

The Colebrook White equation is considered to be more 
accurate than the Hazen Williams equation and has the 
added advantage that roughness values (k) do not vary 
with pipe diameter. 

Fluid Properties allows you to specify the water 
temperature and to model fluids other than water by 
specifying the kinematic viscosity and specific gravity.  
This option is only available if you are using the 
Colebrook White equation. 

 

Run Menu 
Hydraulic Analysis starts an analysis.  This menu item 
will be grey until all data is complete and only then will 
you be able to select it to start an analysis.  If ????? 
appears beside any network component it indicates that 
the data for that component is incomplete.  It could also 
indicate that a reservoir or sprinkler is not located at a 
node, or that one or both ends of a pipe are not touching a 
node. 

In the Building Services version of PIPES, you have the 
option of specifying a maximum velocity in each pipe.  If 
the calculated velocity exceeds the maximum velocity, 
PIPES will offer to upsize the relevant pipes for you at the 
completion of the analysis.  If you accept this offer, the 
results will be recalculated using the revised pipe sizes 
and the affected pipes will be shown in bold.  After you 
right click and edit data on a bold pipe, to see the new 
size, it will appear normally. 

 

Help Menu 
Table of Contents is like the Table of Contents of a text 
book.  It shows topics covered by the help system. 

Index is like the index of a text book.  It invokes a dialog 
box in which you can search for key words. 

Using help is an introduction to the help system. 

About PIPES shows copyright information and the 
version number of PIPES. 
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6   Inspecting 
Results 

After running a hydraulic analysis, the results will be 
displayed on the network diagram for every pipe and 
every node.  By default, the flow in each pipe and the 
HGL at each node will be shown.  You can control what 
results are shown by selecting Pipe Text and Colors or 
Node Text and Colors from the View menu. 

 

 

 

You can right click and edit the data for any network 
component to see the complete results for that component.  
The figure below shows the dialog box for a pipe. 

 

 

 

 

 

HGL Graphs 
You can plot the HGL along one or more pipes by 
selecting HGL Graphs from the View menu. 

You can specify any pipe route for plotting an HGL 
graph.  If you have specified a level for every node along 
the route the ground level will also be plotted. 
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Appendix A 

CONVERSION  OF  
WATSYS DATA  FILES 

 
If you have been using WATSYS you can convert your 
existing data files for use in PIPES.  Most of the effort in 
setting up a data file is spent in collecting and specifying 
data for pipes and nodes.  This data will be automatically 
converted, but data for reservoirs, pumps and valves will 
not.  This is because WATSYS and PIPES are sufficiently 
different in their treatment of these devices that automatic 
data conversion would be too dangerous.   

Before converting any data, you should check the node 
demand data to ensure that it complies with the following 
conventions used in PIPES: 

 the multiplying factor for an area can be 
specified only once.  (eg if Area 1 was 
assigned a multiplying factor of 0.75 for 
some nodes, and a factor of 0.5 for some 
other nodes, you might  define a new Area 
No. 10 for those nodes having a multiplying 
factor of 0.5). 

 If you use more than one sub system in your 
data file, each sub system name must start 
with a different letter. 

These requirements apply across all sub systems used in 
the data file.  If your data breaches any of these 
requirements, you must adjust it to comply.  Once the 
files are converted, you can forget about these 
conventions.  

You must first draw up the network and ensure that the 
node labels shown on the network match those in the 
Watsys data file.  If the Watsys data file uses subsystems 
other than MAIN, the label on the network diagram 
should be prefixed by the first letter of the subsystem 
name.  (eg for node 101 in the Western subsystem, the 
network diagram should show node label W101).  For the 
MAIN subsystem (or if no subsystem names are used), the 
node label shown on the network diagram should be 
exactly the same as that in the Watsys data file. 

Rather than draw up a network from scratch, you may 
prefer to import a DXF file which could be prepared from 
a Watsys map file or from Autocad etc.  When the 
network diagram is ready, you can merge in data from a 
Watsys file using File / Merge Watsys data file. 

It still remains to add reservoirs, valves and pumping 
stations to complete the network.  You can do this using  

 

the Draw menu.  You can then right click and edit the 
data for each component in turn to specify the data. 
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Appendix B 

TECHNIQUES FOR 
LARGE NETWORKS 

 

While using PIPES with large networks we have 
developed certain methods of setting up and checking a 
model.  There are other ways of doing the same thing, but 
these are the methods we prefer. 

 

Using DXF Files 

The first step in setting up a model is to prepare the 
network diagram.  While this can be done within PIPES, 
for large networks we prefer to import a DXF file which 
is produced from a CAD package.  If the DXF file is 
drawn to scale PIPES can determine the lengths for all 
pipes after you specify the length for one pipe.  Often the 
pipes are already included in a CAD drawing.  While this 
appears to save some time there are hidden traps in using 
such a file.  Because every line on a certain layer will be 
interpreted as a pipe (or part of a kinked pipe) it is 
important that each line is drawn once and only once, and 
that there are no stray short lines accidentally drawn.  
These errors are easily made and difficult to detect.  
Unless the original draftperson was aware of these 
requirements we have found it safer and often faster in 
the long run to redraw (trace over) all the pipes on a new 
layer.  Nodes are added on a separate layer to define the 
extents of kinked pipes and the interconnection details.  
We prefer to let PIPES number the nodes automatically. 

 

Using a Spreadsheet for Editing Data 
The next step is to set up demands at nodes.  For large 
networks we prefer to do this in a spreadsheet such as 
Excel.  You should copy the data to the Windows 
clipboard and then paste it into cell A1 of a spreadsheet.  
You can then add demands and ground levels in the 
spreadsheet.  You can also change the node labels here if 
you wish to use a particular labelling system.  When the 
data is finalised select all rows from row 1 to the last row 
of pipe data and choose Edit / Copy.  Then use Alt-tab to 
switch back to PIPES and choose Edit / Paste. 

 

 

 

 

Checking Results 

In very large models (eg 3000 nodes,  4000 pipes) it can 
be a daunting task to look for substandard pressures and 
high headloss pipes on the screen or on a printed diagram 
of results.  To help in checking results you can select Edit 
/ Copy Results to spreadsheet, then switch to an empty 
spreadsheet and select Paste.  The results for for nodes 
are shown on the upper part of the spreadsheet and for 
pipes on the lower part of spreadsheet.   

You can select the node results and sort the data in 
ascending order of pressure.  This will quickly show all 
those nodes with substandard pressures. 

You can also select the pipe results and sort the data in 
descending order of friction slope (m/km).  Excessive 
values of friction slope indicate that this pipe is a good 
candidate for augmentation.  They can also mean that 
there is an error in the network diagram forcing this pipe 
to carry flow which should be carried by another (possibly 
larger) pipe.   

 

 

 

 

 

 

 

 

 


